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West Customer Service

Westlaw Technical and Search Assistance (available 24 hours a day)
If you have general or technical questions about Westlaw, call West Customer Technical Support at
1-800-888-9907 or send an e-mail message to west.support@thomsonreuters.com.

If you have search questions about Westlaw, call the West Reference Attorneys at 
1-800-888-9907 or send an e-mail message to 
west.referenceattorneys@thomsonreuters.com.

Technical and search assistance is also available online at westlaw.com/customersupport.

Accessibility Support
For information on West’s accessibility policy, go to west.thomson.com/accessibility or send an e-mai
message to west.accessibility@thomsonreuters.com.

Billing and Account Assistance
For billing and account assistance, call 1-800-328-4880.

Billing and account assistance is also available online at west.thomson.com/support.

To manage your Westlaw account online, click My Account at west.thomson.com/support.

Westlaw Training
For information about Web-based training, telephone training, or in-person training, visit
west.thomson.com/westlaw/training.

Reference Materials
To browse and order free Westlaw reference materials, visit west.thomson.com/westlaw/guides. West
and other West products also contain valuable online Help.

About This Guide
In this guide, the graphics and step-by-step instructions are based on accessing Westlaw via the Intern
Because of the evolving nature of Internet technology, there may be recent changes to the Westlaw 
interface and functionality that are not reflected in this documentation.
r 
ing to 

 

Limited Warranty
Except as expressly stated in the Westlaw software license agreement, the software is provided “as is” without warranty of any kind, express o
implied, including, but not limited to, warranties of performance or merchantability or fitness for a particular purpose. User bears all risk relat
quality and performance of the software.

ALR, Black’s Law Dictionary, CJS, Federal Supplement, KeyCite, LawDesk, National Reporter System, Premise, Uniform Laws Annotated, United
States Code Annotated, USCA, Westlaw, westlaw.com, West’s California Reporter, and West’s are registered trademarks of West Publishing 
Corporation, used herein under license.

Folio is a registered trademark of Folio Corporation.

Microsoft and Windows are registered trademarks of Microsoft Corporation.
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1 Getting Started

Overview
Premise Research Software (Premise), a software package provided by Thomson Reuters, gives you the 
ability to access and search material stored on compact discs. Premise was designed for use with the 
West CD-ROM Libraries, but it can also be used to access Westlaw. 

This chapter shows you how to perform the following tasks:

• start Premise 

• begin a new research session

• resume work on an existing project

• get help with Premise and your research

• exit the Premise software

Starting Premise
Click the Premise 4 icon or choose Start, Programs, West Applications, then Premise 4 to start 
Premise.

The Premise Welcome window allows you to quickly start your research in one of three ways:

Beginning a New Project
A “project” is the umbrella within which you can perform research for a particular client or case. Each 
time you start new research, Premise creates a new project. Within each project, Premise maintains a 
complete record of your research, including every query you have run and the number of documents 
each query retrieved. In addition, Premise tracks how much time you have spent on each project. 

When you start Premise and click New, a new project is automatically created and given a default name 
(e.g., Project: untitled). You can begin new research by simply selecting a book and starting your 
research. Select a book at the Library window by highlighting it, as shown in Figure 1 on page 2.

Click this button: To do this:

New Begin work in a new project by displaying the 
Library.

Open Resume work in an existing research project. 

Install Install new books from a CD-ROM disc
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Figure 1-1. Library window

The following table explains terminology used with Premise and your West CD-ROM Libraries:

If the Library window is not displayed, you can display it by choosing Library from the Window men

SELECTING A BOOK AND STARTING YOUR RESEARCH

Complete the following steps to select a book and start your research:

1. In the Library window, select the title of the book you want to search.

2. You can start your research by choosing one of the following buttons in the Library window:

• Search. Click Search or double-click the book title to display the Search Book dialog box for th
selected book. You can enter a query in this dialog box. 

Term Definition

Library or Library 
window

The Library window contains a list of the books 
that you have installed. 

Book Each title listed in the Library window is a book. 
You can select one or more books from the 
Library to search or browse.

West CD-ROM 
Libraries

West CD-ROM Libraries are collections of 
information produced by West that you can 
search using Premise. Some examples are 
West’s California Reporter and West’s Social 
Security Library. A West CD-ROM library may 
consist of several books; for example, the 
Arizona Reports library contains Arizona Reports 
and Arizona Attorney General Opinions, each of 
which is a separate book.
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• Scope/First Page. Click Scope to view the first page of the selected book, which usually contains 
coverage information for West CD-ROM Libraries books. 

• Document List. Click Doc List to view a list of all documents included in the current book.

• Retrieve Document. When you know the citation of the document you want to retrieve, click 
Retrieve Doc. 

SAVING YOUR RESEARCH

1. When you have completed your research, choose Save Project from the File menu. 

2. Type a new project name in the Filename text box. The filename can be up to eight characters long. 
If you do not specify a file extension,.prj will be used.

The project will be saved in the path and subdirectory shown in the Directory field unless you specify 
another location. You can save the project in another location by typing it in the Filename text box with 
the project name. For example, to save a project named DAVIDSON in your network user directory, you 
could type s:\user\davidson.

Entering information in the Project Description and Client Identifier text boxes is optional. Information 
you enter in these boxes will be displayed in the Project summary window for this project.

3. Click OK.

Your project is still open, and the Project window’s title bar displays the name you assigned to the 
project.

OPENING AN EXISTING PROJECT

To open an existing research project, complete the following steps:

1. Choose Open Project from the File menu. The Project Summary dialog box for the current project 
appears. Click OK to close this dialog box.

2. Select a project from the Files list box.

3. Click OK.

The Project window displays a chronological list of the steps you have taken in this project, including 
each activity, the book it was performed in, and the number of documents retrieved.

You can perform any of your previous research steps again by selecting it in the list and then choosing 
Go to Item.

VIEWING THE PROJECT SUMMARY

Choose Project Summary from the File menu to view the session time, total time, and total Westlaw 
time spent on the current project and to see the Notebook file being used for the project.

If you want to store the summary information with your project, enter a description and client ID and 
click OK. If you do not want to store the information with your project, click Cancel. Click Print to print 
the project summary information.

Note You can go to the Library window and run a new query or retrieve another document by choosing 
Library from the Window menu.
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EXITING PREMISE

To close the Premise software, choose Exit Premise from the File menu.
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2 Retrieving Documents by Citation or 
Title

Overview
One of the most valuable tools Premise provides is the ability to quickly and easily retrieve a document 
when you know its citation or title. This chapter shows you how to perform the following tasks:

• retrieve a case when you know its citation

• retrieve a statute when you know its citation

• retrieve a case when you know its title

Retrieving Case Law by Citation
The method you use to retrieve a case when you know a citation varies, depending on whether you are 
searching in a library that consists of several discs or just one disc. 

SINGLE-DISC LIBRARIES

When you know the citation of a case and you have a single-disc library, use the Retrieve Document 
command.

1. Select the book, e.g., Federal Reporter, in the Library.

2. Click Retrieve Doc in the lower right corner of the window.

The Retrieve Document dialog box is displayed.

Figure 2-1. Retrieve Document in Book dialog box

3. Type your citation with or without spaces or periods in the Citation text box. For example, to 
retrieve the case cited at 821 P.2d 714, type 821p2d714.

4. Click OK.
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MULTIPLE-DISC LIBRARIES

You can retrieve a document by citation from a multiple-disc library in two ways:

• If you know which disc contains your case, complete the steps listed below.

• If you are not sure which disc your case is on, complete the steps for “Retrieving Documents Us
the Table of Cases Book” below.

To retrieve a specific case when you know the citation to a publication printed on the disc, complete
following steps:

1. Select the book in the Library that contains the volume number of the case you want to retriev
For example, if you want to retrieve 112 S.Ct. 674, select Supreme Ct. Rapture, 91-116 S.Ct.

2. Click Retrieve Doc.

3. Type your citation with or without spaces or periods in the Citation text box. For example, type 
112sct674.

4. Click OK.

RETRIEVING DOCUMENTS USING THE TABLE OF CASES BOOK

When you are not sure which disc contains your case, you can retrieve it by using the Retrieve Docum
command in the Table of Cases book. 

1. Select the Table of Cases book, e.g., Supreme Court Reporter Table of Cases, from the Library

2. Click Retrieve Doc.

The Retrieve Document in Book dialog box is displayed.

3. Type your citation with or without spaces or periods. For example, to retrieve 59 U.S.L.W. 4519
type 59uslw4519.

4. Click OK.

5. Click the right Term arrow to go directly to your case in the list. 

The citation you searched for appears in bold red type.

6. Double-click the citation to jump directly to the case.

Note You may be prompted to insert another disc.

RETRIEVING STATUTES BY CITATION

When you know the statute or rule section, article or paragraph number, you can retrieve the statut
rule by restricting your search to the citation field.

To retrieve a statute when you know the citation, complete the following steps:

1. From the Library window, select a statutes book.

2. Click Search.

The Fields Template is displayed.

Note If the Fields Template is not displayed, select Fields Template from the Search Using dr
down box.
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Figure 2-2. Fields Template dialog box

3. Select Document List from the View Results As drop-down list to view your search result in a list. 
Select Document Text to view the first page of your search result.

4. Type the citation of the statute you want to retrieve in the Citation text box. For example, to retrieve 
Colo. Rev. Stat. Ann. § 24-80-910, type 24-80-910.

5. Click Search. 

The document list search result is displayed.

Note To view the full text of a document in a document list search result, click View Doc.

Retrieving Case Law by Title
The method you use to retrieve a case when you know the party names varies, depending on whether 
you are searching in a library that consists of several discs or just one disc.

SINGLE-DISC LIBRARIES

When you know the names of the parties in a case, you can retrieve the case by running a title field 
search.

1. Select the book, e.g., Wisconsin Reporter, in the Library.

2. Click Search.

The Fields Template is displayed.

Note If the Fields Template is not displayed, select Fields Template from the Search Using drop-
down list. 
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Figure 2-3. Fields Template dialog box

3. Select Document List from the View Results As drop-down list to view your search result in a li
Select Document Text to view the first page of your search result.

4. Type the names of the parties you are searching for, separated by a space, in the Fields text bo
For example, to retrieve Jo Ann Allison v. Merck and Company, Inc., type allison merck.

5. Click Search.

Note You do not need to enter the full name of each party. Do not include abbreviations such
Co., Corp. or Inc. 

The document list search result is displayed.

Note To view the full text of a document in a document list search result, select it and click Vi
Doc.

MULTIPLE-DISC LIBRARIES
When you know the names of the parties in a case, you can retrieve your case by running a search in
Table of Cases book and then jumping to your case from the list.

1. Select the Table of Cases book, e.g., Wisconsin Table of Cases, in the Library. 

2. Click Search.

The Fields Template is displayed.

Note If the Fields Template is not displayed, select Fields Template from the Search Using dr
down list.
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Figure 2-4. Fields Template

3. Type the names of the parties separated by a space in the Title text box. For example, to retrieve 
Sands v. Morongo Unified School District, type sands morongo.

4. Click Search.

Note You do not need to enter the full name of each party. Do not include abbreviations such as 
Co., Corp. or Inc. 

• If you view your result as Document Text, the first page of the Wisconsin Table of Cases book is 
displayed.

• If you view your result as a Document List, a result list is displayed. Select a document from the list 
and click View Doc.

5. Click the right Term arrow to go directly to your case in the list.

The party names you searched for appear in bold red type.

6. Double-click the citation, underlined in blue type, that corresponds to your case to jump directly to 
the case.

Note You may be prompted to insert another disc.
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3 Retrieving Documents 

Overview
One of the advantages of using Premise is the ability to retrieve documents by searching for descriptive 
words. This chapter shows you how to perform the following tasks:

• select a book or books to search

• select an appropriate search method

• retrieve documents using a Natural Language search

• retrieve documents using a Terms and Connectors search

• restrict your search to selected sections or fields of a document by using the Fields Template

Selecting Books to Search
Premise gives you the ability to search one book or run a search across multiple books.

To select the books you want to search, complete the following steps:

1. From the Library, select the book you want to search. To select multiple books, click the first book 
you want to search, then hold down the Ctrl key and click each additional book title.

2. After you have selected all of the books that you want to search, click Search.

3. Enter your query in the Search Book or Search Multiple Books dialog box and click Search. 

During the search, you are prompted to switch discs as required.

4. After you run your query in a single book, a list of result documents is displayed. After you run your 
query in multiple books, the number of search results for each book is displayed.

Premise offers you a choice of search methods to make your research as accurate, efficient and 
complete as possible. The type of research and your knowledge of the research issue determine which 
method is best suited to your needs. 

NATURAL LANGUAGE

The Natural Language search method allows you to retrieve documents by typing a description in plain 
English. Premise then displays the documents that most closely match the concepts in your 
description. 

Because Natural Language is easy to use, you can quickly retrieve relevant documents the first time you 
use Premise. If you are an experienced Premise user, you can use Natural Language as an additional 
tool to increase the thoroughness of your research. Natural Language can be especially effective when 
you are dealing with complex issues.

TERMS AND CONNECTORS

When you use the Terms and Connectors search method, you enter a query that consists of key terms 
from your issue and connectors specifying the relationship between those terms. Use this method when 
you want your search terms to appear within a certain proximity of each other or you want to retrieve all 
cases containing your search terms. 
Retrieving Documents      11
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FIELDS TEMPLATE

The documents in West CD-ROM Libraries and on Westlaw are composed of unique sections of 
information called fields. The Fields Template is a fill-in-the-blank template that allows you to rest
your search to certain fields, such as the title field. Unlike Terms and Connectors, you do not need t
supply a connector between terms. The /p connector is automatically placed between your search 
terms so Premise looks for them in the same paragraph. You may use a different connector if you 
choose.

SEARCHING WITH NATURAL LANGUAGE

To begin a Natural Language search, complete the following steps:

1. From the Library, select the book(s) you want to search.

2. Click Search.

A dialog box similar to the one shown below is displayed:

Figure 3-1.  Natural Language dialog box

Note If the Natural Language dialog box is not displayed, select Natural Language from the 
Search Using drop-down list.

ENTERING A DESCRIPTION AND DISPLAYING YOUR RESULT

Suppose your issue concerns whether a manufacturer must disclose the side effects of a drug. To 
retrieve cases discussing this issue, type a description like the following and then click Search:

must a manufacturer disclose the side effects of a drug 

Premise processes your description and displays the 20 documents most closely matching the conce
in your description, beginning with the document that has the greatest likelihood of matching.

When you search using Natural Language, your documents are ranked by statistical relevance with
document most closely matching your description ranked first. 

Type your Natural 
Language description in 
this text box.

Any restrictions that you 
specify are displayed in 
this list box.

All available field 
restrictions are 
displayed in this list box.
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ADDING ALTERNATIVE CONCEPTS TO YOUR DESCRIPTION

You can increase the efficiency of your Natural Language search by adding alternative concepts to your 
description. To add alternative concepts to your description, use the Premise thesaurus or add your own 
concepts.

Using the Premise Thesaurus

The Premise thesaurus provides a list of concepts you can add to your description. To add related 
concepts to your description, complete the following steps.

1. In the Natural Language dialog box, type your description and click Thesaurus.

A dialog box similar to the one shown below is displayed:

Figure 3-2. Thesaurus dialog box

2. Select the concept for which you would like to see related concepts from the Concepts that have 
Related Concepts list box. For example, select manufacturer to display a list of related concepts in 
the Related Concepts list box.

3. Select the alternative concepts that you want to add to your description from the Related Concepts 
list box. For example, select producer and wholesaler to add these concepts to your description.

4. The concepts are placed in parentheses and added to your description in the Current Description 
list box.

5. Click OK to return to the Natural Language dialog box.

Adding Your Own Alternative Concepts

Although the Premise thesaurus provides many alternatives from which to choose, it should not be 
substituted for your own judgment. For instance, the thesaurus does not offer terms with opposite 
meaning (antonyms). Therefore, if you want to add an antonym to your description, you must add it 
yourself. To add your own alternative concept, simply type the alternative concept in parentheses 
immediately following the concept to which it relates, e.g., constitutional (unconstitutional).
Retrieving Documents      13
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Creating Your Own Phrases

You can create your own phrases by enclosing the words in quotation marks (“”). For example, if yo
would like to include the phrase law practice in your description, type “law practice.” Create your ow
phrases only when you are sure that you want the words to appear in the order indicated within the
quotation marks.

Adding Restrictions to Your Description

You can limit your Natural Language description to a specific court, judge, attorney or date by addin
field restriction. To add a restriction to your description, complete the following steps:

1. In the Natural Language dialog box, select a restriction, e.g., Judge, in the Restrictions list box.

The Field Content dialog box is displayed.

2. Type the information for which you want to restrict your search. For example, to restrict your sea
to cases in which Justice Souter wrote the majority opinion, type souter in the text box and click

Premise retrieves the documents that satisfy your description and any restrictions you specify.

Searching with Terms and Connectors
Formulating a Terms and Connectors query is a two-step process:

1. Choose your search terms.

• Isolate the important terms from your issue.

• List alternative terms (synonyms and antonyms).

• Insert root expanders and universal characters where appropriate.

2. Place connectors between the terms.

CHOOSING YOUR SEARCH TERMS

The first step in formulating a Terms and Connectors query is stating your issue and isolating the k
terms. For example, suppose your issue is the statute of limitations for the fraudulent concealment 
defect or condition

Your goal in selecting search terms is to select unique terms that describe your issue. Selecting a fe
unique terms more effectively narrows your search result than selecting general terms. In this exam
the important terms are

• statute of limitations

• fraudulent concealment

• defect

• condition

When selecting search terms, you must take into account the various forms in which they might occ
Premise searches for some variations of terms automatically, such as plurals. In other cases, you m
tell Premise to search for certain variations.
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The following subsections explain in detail how Premise searches for terms.

Compound Words

A compound word may appear in various ways, such as hyphenated or as one word or two words. If your 
search term is a compound word, use its hyphenated form to retrieve all variations, such as whistle-
blow!

Acronyms

Like compound words, acronyms appear in various ways in documents. If your search term is an 
acronym that may appear with or without periods, enter it with periods and no spaces, such as h.i.v.

Plurals and Equivalencies

Premise automatically retrieves regular and irregular plurals when you enter the singular form of a 
term. This capability is called the “automatic pluralizer.”

Note The automatic pluralizer operates only when you enter the singular form of the term. When 
you enter a plural form, Premise only retrieves the plural form. 

Following are examples of regular and irregular plurals automatically retrieved by Premise when you 
enter a singular term:

Premise automatically retrieves equivalencies of terms. For example, 5 and five are equivalents, as are 
August and Aug. This means when you search for either term, you retrieve both terms. 

Words Too Common to Search: Stop Words

Some words, such as the or with, are too common to be searched efficiently. These terms are called stop 
words. If you include a stop word in your query, Premise displays the following message:

Your query contains one or more terms that are too common to search. Please rephrase your query 
and try again.

You can only use a stop word if it is embedded in a phrase search. Note, however, that the stop word is 
not searched; rather it acts as a placeholder for a term. 

The term: Retrieves:

car car, cars

bonus bonus, bonuses

penny penny, pennies

memorandum memorandum, memoranda, memorandums

alumnus alumnus, alumni

child child, children
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For example, if you use the stop word without in the phrase, any of the following might be retrieved

This query retrieves any document in which judgment  precedes prejudice  by two words.

Note Stop words cannot be the first or last word in a phrase search.

Listing Alternative Terms (Synonyms and Antonyms)

After choosing your primary search terms, you need to consider which alternative terms are necessa
You should consider both synonyms and antonyms.

Root Expander (!)

To retrieve words with variant endings, place the root expander (!) at the end of a root term to retrie
all possible endings of that root. The following table shows some examples:

The root expander does not retrieve related terms that do not begin with the root word. To search f
these forms, use the universal character (*), which is described in the following section. 

You can only place the root expander at the end of a term. You do not need to use the root expande
retrieve plurals or possessives, as both are retrieved automatically.

The phrase: Retrieves:

“judgment without prejudice” judgment, without 
prejudice 

judgment with prejudice 

judgments regarding 
prejudice 

judgment might 
prejudice 

judgment, this prejudice

If your primary search 
term is:

Consider also searching for alternative 
terms:

good faith bad faith

admissible inadmissible

statute of limitations limitation of actions;
limitation period

The term: Retrieves: But 
not:

know! know, knows, known, knowing, 
knowingly, knowable, knowledge, 
knowledgeable

knew

obey! obey, obeys, obeyed disobey

object! object, objected, objection, objecting
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Universal Character (*)

The universal character (*) represents one character. You can place the universal character in the 
middle or at the end of a term, but not at the beginning of a term. When you place the universal 
character at the end of a term, you specify the maximum length of that term. You can also combine 
universal characters and the root expander in one term, such as kn*w!.

Examples of using the universal character are shown below:

Phrases

To search for a phrase, you must place the phrase in quotation marks. For example, to search for the 
phrase summary judgment, type “summary judgment.” Phrase searching should only be used when 
you are certain that the phrase will not appear in other ways.

Note You can use root expanders and universal characters, described in this section, within a 
phrase search. Search terms placed inside quotation marks will also retrieve their automatic 
equivalencies, plurals and possessives.

Choosing Connectors

Connectors are symbols you place between search terms to specify the relationship between them. For 
example, you can specify that terms appear in the same sentence, in the same paragraph, or within a 
certain number of terms of each other in retrieved documents.

The term: Retrieves: But not:

object*** object, objects, objected, 
objection, objecting

objectives, 
objections, 
objectionable

fea*t feast feat

s****holder shareholder, stockholder

kn*w know, knew knowledge, 
knows, knowingly
Retrieving Documents      17



t 

When you are choosing connectors, keep in mind the types of documents you want to retrieve. By 
selecting appropriate connectors, you can retrieve the most relevant documents.The following char
lists the connectors you can use:

1 With Terms and Connectors, you can use a space between terms instead of the or.

2 Use the % (BUT NOT) connector with caution, as it may cause relevant documents to be excluded.

Type of 
connector

Looks
like

Explanation Example

OR or1 At least one of the terms 
must be in the document.

attorney or 
lawyer

AND &, and Both terms must appear in 
the document.

canal & 
flood

Connectors /p Terms on either side of /p 
must appear in the same 
paragraph.

suppress! /p 
evidence

+p Terms to the left of +p must 
precede terms to the right of 
+p in the same paragraph.

age +p 
discriminat!

/s Terms on either side of /s 
must appear in the same 
sentence.

slip! /s fall!

+s Terms to the left of +s must 
precede terms to the right of 
+s within the same sentence.

directed +s 
verdict

Numerical 
Connectors

/n Terms must occur within n 
terms of each other (where n 
is a specific number).

john /3 
davidson

+n Terms to the left of +n must 
precede terms to the right of 
+n and be within n terms of 
each other (where n is a 
specific number).

249 +5 218

Phrase “ ” Terms must appear in the 
same order as they do in the 
quotation marks.

“public 
policy”

BUT NOT %2 Documents containing any 
of the terms listed after the 
% are excluded.

warn! % 
danger
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Restricting Your Search to Fields

The documents in West CD-ROM Libraries are composed of unique sections of information called 
fields. You can limit your Terms and Connectors search to a specific court, judge, attorney, or date by 
adding a field restriction. Although you are searching only a portion of the document, the entire 
document is retrieved for viewing. (Premise automatically searches all fields in a document when you 
do not use field restrictions.) 

For example, to restrict your search to documents decided or issued on, before or after a certain date, or 
between a range of dates, type da followed by the date or date range in parentheses. Many date 
restriction formats are acceptable:

da(3-1-93)  da(bef 3-1-93)  da(before 1993) da(aft 1990 and bef 1993)

Connect the date restriction to the rest of your Terms and Connectors query with an and (&) connector. 

USING TERMS AND CONNECTORS 

After creating a query using terms and connectors, you can type the query in the Terms and Connectors 
dialog box and run your search.

1. From the Library, select the book or books you want to search and click Search.

Note If the Terms and Connectors dialog box is not displayed, select Term Search from the Search 
Using drop-down box.

Figure 3-3. Terms and Connectors dialog box

2. Type your query in the Terms and Connectors Query text box, e.g., type
limitation /3 statute action period /p fraud! 

Note Your search time increases with the number of root expanders and connectors you use.

3. Click Search to run your search. Premise retrieves the documents that satisfy your query.

Type your Terms and 
Connectors query in this 
text box.

This list box displays all 
the connectors you can 
place between terms.

This list box displays the 
symbols for the root 
expander and the 
universal character.
Retrieving Documents      19



 
ch 

ch 

r is
t! in 

 the 

rch 
 

Using Fields Template
The Fields Template is an alternative to the Terms and Connectors dialog box. The Fields Template
allows you to run a query without typing connectors or field restrictions. It displays a text box for ea
field in the document.

To search, for example, for cases from the Supreme Court of Florida that were dismissed as moot, 
complete the following steps:

1. From the Library, select Florida Cases, 421-687 So.2d and click Search.

Note If the Fields Template dialog box is not displayed, select Fields Template from the Sear
Using drop-down list.

Figure 3-4. Fields Template dialog box

2. Type dismiss! moot!, separated by a space, in the Synopsis text box.

Select the connector from the Default Connector drop-down list. In this example, the connecto
/p or same paragraph. Therefore, this query will look for dismiss! in the same paragraph as moo
the synopsis field.

You can also type your own connector, which is then used instead of the connector specified in
Default Connector drop-down list box.

3. Type supreme in the Court text box.

4. Click Search.

Note The AND (&) connector is always used to connect fields. In this example, Premise will sea
for documents with any form of the terms dismiss and moot in the synopsis field and the
term supreme in the court field.

Type your search terms 
here to search the full 
text of a document.

Type your search terms 
in one or more of the 
field text boxes to limit 
your search to the 
field(s).

Choose the default 
connector used 
between the terms.
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4 Browsing Documents

Overview
This chapter explains the following features:

• browsing a document, a search result, or a full book

• browsing a multiple-book search result

• jumping to referenced information

• using the See Also command

• viewing and printing images

• using personal notations

Viewing the Document List
If you select the Document List display option in the Search dialog box and perform a search, the 
documents you retrieve are displayed in a list window.

Figure 4-1.  Welcome to Westlaw page

The Document List window displays each document’s citation, title, and other relevant information. 

The query you used to retrieve the document is also displayed at the top of the window. If you have not 
performed a search, the List window provides a list of all the documents in the current book.
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FINDING SPECIFIC TERMS IN THE DOCUMENT LIST

You can search for a specific term or series of characters within document titles in the List window b
using the Find command. Complete the following steps to use the Find command:

1. In the List window, choose Find from the Edit menu.

The Find dialog box is displayed:

Figure 4-2. Find dialog box

2. Type the term or series of characters you want to search for in the Find what text box, such as 
braverman.

You can customize your search by choosing any of the following options:

• Select the Whole Words Only check box to search for words exactly as typed (no plurals or oth
combinations of the words will be found).

• Select the Wrap Around check box to search all documents in the list. The search will proceed
the end of the titles in the list, and then continue through the list from the beginning.

• Select the Case Sensitive check box to require that the case (uppercase or lowercase) of the te
you are searching for exactly matches that of the terms in the list.

3. Click OK. The entry containing your terms is highlighted.

4. To move to the next occurrence of your terms, choose Find Again from the Edit menu.

Reordering the Document List

In some books, you can change the display order of listed documents. The display options vary by 
library. Following is an example of options that might be available:

• chronological order by court

• reverse chronological order by court

• reverse chronological order 

• alphabetical order by title

• print publication
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If you are doing a Natural Language search, the following options are available for reordering the 
Result List:

• statistical relevance

• reverse publication order

To change the order of the list, choose Reorder Documents by from the Browse menu, and then select 
the Order option. The result list is rearranged in the order you selected.

Browsing Your Results

If you select the Document Text display option in the Search dialog box and perform a search or retrieve 
a document, your result is displayed in the Text window. 

The Document Text window includes several useful features and commands for browsing your result. 
Following are descriptions of the ways you can browse your result.

Browsing by Search Term

When you perform a search, your search terms are displayed in bold red type in your search result. You 
can browse by search term to view only the pages of the document that contain your search terms. 

To advance to the next search term in a search result, choose the right Term arrow. To view the previous 
term, choose the left Term arrow.

Note You can also view the next or previous occurrence of your search terms by choosing Next Term or 
Previous Term from the Browse menu.

Browsing the Best Portion of Your Result

The Best command displays the pages containing the portion of a document most closely matching the 
concepts in your Natural Language description. Click the right Best arrow to view the best section of the 
current or next document. Click the left Best arrow to return to previous sections with better results.

Note You can also view the best sections of the next or previous document by choosing Next Best 
Section or Previous Best Section from the Browse menu.

Browsing by Line

You can move line by line through the displayed document by clicking the down scroll arrow at the 
bottom of the vertical scroll bar or by pressing the down arrow key.

You can also move backward line by line through a document by clicking the up scroll arrow at the top 
of the vertical scroll bar, or by pressing the up arrow key.

Browsing by Screen

You can view the displayed document screen by screen by clicking above or below the scroll box in the 
vertical scroll bar, or by pressing the Page Up and Page Down keys.

Browsing by Page

You can view the next or previous book page of the displayed document by choosing Next Page or Prev 
Page from the Browse menu.

Note A book page is the page as it would appear in a print publication, such as in a West reporter. 
Therefore, the next book page in a case law document is the beginning of the next page in the 
print publication.
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 Complete the following steps to view a specific book page:

1. Choose Specific Book Page from the Browse menu.

The Specific Book Page dialog box is displayed:

Figure 4-3.  Specific Book Page dialog box

2. Type the number of the specific book page you want to view. For case law books, the specific p
number includes the volume number, publication abbreviation, and page number, such as 
413se2d153.

3. Click OK.

FINDING SPECIFIC TERMS WITHIN DOCUMENTS

You can search for a specific term or series of characters within documents using the Find comman
Complete the following steps to use the Find command:

1. Choose Find from the Edit menu.

The Find dialog box is displayed:

Figure 4-4. Find dialog box

2. Type the term or series of characters you want to search for in the Find what box, for example, t
testimony. 

Choose any of the following options for your search:

•  Select the Whole Words Only check box to search for words exactly as typed (no plurals or oth
combinations of the words will be found).

•  Select the Wrap Around check box to search all of the current document. The search will proc
to the end of the document, and then continue from the beginning of the document.
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• Select the Case Sensitive check box to require that the case (uppercase or lowercase) of the terms 
you are searching for exactly matches that of the terms in the document.

•  Select the Across Documents check box to search all documents in your result or book.

3. Click OK. The first occurrence of your search terms is highlighted.

4. To move to the next occurrence of your search terms, choose Find Again from the Edit menu.

Browsing by Document

To view the next document in a search result, click the right Doc button at the bottom of the Text 
window. To view the previous document, click the left Doc button. 

You can also browse the next or previous document by choosing Next Document or Previous 
Document from the Browse menu.

Browsing All the Documents in a Book

You can view all of the documents in a book even if they were not retrieved by your search. To do this, 
you must first display a Text window. Then choose All Documents from the Browse menu. All the 
documents are displayed beginning with the document you are viewing.

To return to your search result, close the window or choose your search result from the Window menu.

Moving to a Specific Document

You can move to a specific document in a search result or in a full book by selecting it from the 
Document List window. Complete the following steps to move to a specific document:

1. Click Doc List.

The Document List window is displayed. It lists all documents that satisfy your query or are 
included in the current book. 

2. Scroll through the list until you reach the document you want to view. With the desired document 
highlighted, click View Doc.

Browsing Between Books in a Multiple-Book Search Result

After performing a multiple-book search, a summary of your search results is displayed in the Multi-
Book Search window. This window lists each book you searched and the number of documents in each 
book that satisfied your query. You can select a book and then view either a list of documents or the full 
text of the first document that satisfied your query.

To view a list of result documents for a particular book, select the book from the Multi-Book Search 
window and click Doc List.

To view the full text of the first result document for a particular book, select the book from the Multi-
Book Search window and click View Doc.

To return to the Multi-Book Search window, click MBS Summary or choose Multi-Book Search 
Summary from the Browse menu.

The Project window allows you to see a list of the results for each book you searched. The Project 
window shows you how many documents were retrieved in each book. You can easily view the result of 
a specific book now, or run the search again in any of the books during a future session by choosing the 
result and then choosing Go to Item.
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Jumping to Referenced Information

When you are viewing a document, you can use hypertext references to quickly jump to any referen
information. For example, you can jump to the text of a cited case or to the relevant portion of an 
opinion from a headnote. 

You can jump to referenced information by double-clicking the jump marker next to the hypertext 
reference or any of the reference text. By default, the hypertext references appear underlined in blu
type. You can change the font and color of your hypertext references in Preferences. 

If you are jumping to a cited document, the referenced document’s first page is displayed. If the 
document is contained on a different disc, you are prompted to insert the correct disc.

When you are finished viewing the referenced information, you can return to your original location b
closing the window.

Using the See Also Command
Choose See Also from the Browse menu to view additional material that is not explicitly referenced
the displayed document but is related to it, such as a pocket part document. Additionally, the See A
command allows you to move to a specific portion of a document. For example, when viewing a stat
use the See Also command to view historical notes or notes of decisions.

This command is only active when See Also material is available for the document.

Making Personal Notations
Personal notations allow you to add your own annotations to your CD-ROM research. There are fou
types of personal notations available in Premise:

• bookmarks

• sticky notes

• highlighting

• attachments

Note In a few situations, the notations that you add will not be positioned correctly after you 
install a new update CD-ROM disc. This occurs because Premise does not reposition you
personal notations within data that shifts significantly. Text you annotated may have shi
within the document, causing your notations to be misplaced.

Note Personal notations are not available for research you perform on Westlaw through Prem

BOOKMARKS

Use the Bookmark feature to mark an important location in a document for later reference.

ADDING A BOOKMARK

To add a bookmark to your document, complete the following steps:

1. Place the cursor in your document where you want to add a bookmark.

2. Choose Bookmark from the Notations menu or click the Bookmark button on the toolbar.

3. Type a bookmark name in the Enter a Bookmark Name text box, for example, breach of warran

4. Click Save. A bookmark icon is inserted in the text.
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Going to Bookmarks

To return to the place in a document where you added a bookmark, complete the following steps:

1. Choose Go To Bookmark from the Notations menu.

2. Type the first few letters of the bookmark name in the first text box.

3. Select the bookmark name in the second text box.

4. Click Go To. The document page containing the bookmark is displayed.

Deleting a Bookmark

To delete a bookmark, complete the following steps:

1. Click the bookmark icon in the text that you want to delete. The Edit Bookmark dialog box is 
displayed.

2. Click Delete.

STICKY NOTES

Use the Sticky Note feature for adding your own notes while you are working within a document.

Adding a Sticky Note

Complete the following steps to create a sticky note:

1. Place the cursor in the document where you want the sticky note to display.

2. Choose Sticky Note-Yellow from the Notations menu or click the Sticky Note button on the 
toolbar.

3. You can also click the right mouse button to display the Notations menu.

4. Type your notes in the sticky note. 

5. Click the close box in the upper right corner of the sticky note to close it. A sticky note icon is 
displayed in the text.

Opening a Sticky Note

If you are browsing a document and want to read an attached sticky note, click the sticky note icon to 
open it.

Deleting a Sticky Note

Click the Sticky Note icon in the text that you want to delete, and then choose Delete Notation from the 
Notations menu.

Highlight Pen

Use the highlight pen feature to mark important text for later reference, just as you would use a 
highlighting marker to accent a paper document.

Highlighting Selected Text

1. Select the text you want to highlight.

2. Choose Highlight Selected Text from the Notations menu.
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Highlighting Large Text Areas

1. Choose Highlight Pen-Yellow from the Notations menu or click the Highlight button on the 
toolbar.

Your cursor changes to a roller, indicating that the highlight pen is turned on.

2. Move the roller over the text you want to highlight.

Note While the highlight pen is on, you can scroll through a document and select additional t
you want to highlight.

3. To turn off the highlight pen, press the Esc key.

Going to Highlighted Text

To view a particular section that has been highlighted, complete the following steps:

1. Choose Notation List from the Notations menu.

2. Select the notation with the highlighted text you want to view.

3. Click Go To Item to jump to the section of your document containing the highlighted text.

Removing Highlighting From Text

Select the text that you want to remove highlighting from, and then choose Delete Notation from t
Notations menu.

ATTACH ITEM

Use the Attach Item feature for attaching a non-Premise file, such as a spreadsheet or word-process
document, to a document in a Premise book.

Attaching a File or Application

To attach a document to your book text, complete the following steps:

1. Place the cursor in your document where you want to attach a document.

2. Choose Attach Item from the Notations menu.

The Attach Item dialog box is displayed.

3. Select the file you want to attach and click OK.

The Attach item icon is displayed in the text.

Launching an Attached File or Application

To open an attached file or application, complete the following steps:

1. Click the Attach item icon.

2. Click Yes to open the attachment.

3. If a program is not associated with the attached item file, you are asked to select the applicatio
open it with.

Removing an Attached Item

To remove an attached item, follow these steps:

1. Choose Notation List from the Notations menu.

2. Select the notation with the attached item you want to delete.
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3. Click Delete Item.

Setting the Location of Notation Files

Choose Set Notation Path from the Notations menu to set the path where the Notations files are 
stored.

Note If a public directory on a local area network is selected, everyone set to that directory will 
view and create notations using the public notations file. If a specific user directory is 
selected, the notations are specific to the user.

Selecting Labels and Colors for Your Notations

Premise allows you to categorize your notations by assigning labels and colors to them. You can 
arrange labels by project, priority, or any variable you choose. For example, you can assign a label and 
color for all your notations about a particular research assignment.

To categorize your notations by name and color, complete the following steps:

1. Click Add to create a new label. 

2. Enter a label name in the Please Enter a New Label text box and click OK. 

The Select Label dialog box is displayed again.

3. Select a label color from the Label Color drop-down list box.

4. Click OK to save your label and color.

Editing a Label

To edit a label, complete the following steps:

1. Choose Select Label/Color from the Notations menu.

2. Select the label in the Label list box and click Edit. 

3. Enter a label name in the Change Label To text box and click OK.

The Select Label dialog box is displayed again.

4. Select a label color from the Label Color drop-down list box.

5. Click OK to save your label and color.

Removing a Label

To remove a label, complete the following steps:

1. Choose Select Label/Color from the Notations menu.

2. Select the label in the Label list box and click Remove.

3. Click Yes to delete the label.

4. Click OK to close the dialog box.
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5 Printing and Downloading

Overview
This chapter explains the following features:

• printing a document or list

• downloading a document or list

• copying and pasting text

• using the Notebook 

The information you can print or download (e.g., selected text or a complete document) depends on 
whether you are viewing document text or a list.

Printing a Document or a List 
The Print command on the File menu allows you to print information from Premise and your installed 
books. Your printing options vary depending on whether you are viewing a list or a document when you 
choose the Print command.

Printing a Document
When you are viewing one or more documents in the Text window, you can print any of the following:

• selected text

• the displayed document

• selected pages of the document

Note You can print multiple documents from the List window. 

You can also select any of the following options for printing:

• dual column or book-style printing, as in a West reporter page

• full justification or single-column printing, as in statutes documents

• printing your personal notations

• printing your search terms in bold type

• printing the banner page

• printing inline images

• printing status flags 
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Complete the following steps to print any of the previously listed items from the Text window:

1. Choose Print from the File menu or click the Print button on the toolbar.

The Print dialog box is displayed, as shown below:

Figure 5-1. Print dialog box

2. Select the information you want to print, e.g., selected text, a full document, or a range of pag
by selecting the appropriate button in the Print box.

3. Select your printing options in the Options box. Following are examples of printing options:

• To print a full document in dual-column format, select Document and Dual Column.

• To print a document in single-column format, select Document and Full Justification. This opt
is useful for printing statutes documents.

• To print a document with personal notations in dual-column format, select Document, Dual 
Column, and Personal Notations.

• To print selected pages of a document in dual-column format with the search terms in bold ty
select Pages (type in the page numbers), Dual Column, and Bold Query Terms.

• To print a document with the banner or copyright page and inline images, select Document, 
Banner Page, and Inline Images.

Note The Selected Text option is only available after you have highlighted text in the documen
that you want to print. Full–justification printing is the only printing choice available wh
printing selected text.

4. Type your name in the Requestor text box and select Banner Page in the Printing Options if yo
want your name to appear on the printout.

5. Click OK.
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PRINTING A LIST OR MULTIPLE DOCUMENTS

When you are viewing the Document List window or the Library, you can print any of the following:

• the entire list of document titles and citations, or the list of book titles

• selected documents

Complete the following steps to print any of the above items:

1. Choose Print from the File menu.

The Print dialog box is displayed, as shown below:

Figure 5-2. Print dialog box

2. Select the information you want to print by clicking the corresponding options.

Note The Selected Documents option is only available when you are viewing a list of documents at 
the List window and you have highlighted the document titles that you want to print. The 
following table describes how to select multiple documents in the List window:

3. Select your printing options by clicking the corresponding check boxes in the Printing Options box.

To Select Do This

Multiple documents Click the first document title that you want to print, 
then hold down the Ctrl key and click the title of each 
additional document you want to print. 

Multiple contiguous 
documents

Click the first document title that you want to print, 
then hold down the Shift key and click the last 
document title you want to print.

All documents in the 
list

Choose Select All from the Edit menu.
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